Gentran:Server® for Windows®

Connect:Direct® Gateway
Configuration Guide

Version 5.1

Sterling Commerce
An IBM Company

4232-510-USER23-0000



Copyright Notice

Gentran:Server for Windows
© Copyright 1995-2005

Sterling Commerce, Inc.

ALL RIGHTS RESERVED

Sterling Commerce Software
Trade Secret Notice

THE GENTRAN:SERVER FOR WINDOWS SOFTWARE ("STERLING COMMERCE SOFTWARE") IS THE CONFIDENTIAL AND
TRADE SECRET PROPERTY OF STERLING COMMERCE, INC., ITS AFFILIATED COMPANIES OR ITS OR THEIR LICENSORS,
AND IS PROVIDED UNDER THE TERMS OF A LICENSE AGREEMENT. NO DUPLICATION OR DISCLOSURE WITHOUT PRIOR
WRITTEN PERMISSION. RESTRICTED RIGHTS.

This documentation, the Sterling Commerce Software it describes, and the information and know-how they contain constitute the
proprietary, confidential and valuable trade secret information of Sterling Commerce, Inc., its affiliated companies or its or their
licensors, and may not be used for any unauthorized purpose, or disclosed to others without the prior written permission of the
applicable Sterling Commerce entity. This documentation and the Sterling Commerce Software that it describes have been provided
pursuant to a license agreement that contains prohibitions against and/or restrictions on their copying, modification and use.
Duplication, in whole or in part, if and when permitted, shall bear this notice and the Sterling Commerce, Inc. copyright notice.

As and when provided to any governmental entity, government contractor or subcontractor subject to the FARs, this documentation is
provided with RESTRICTED RIGHTS under Title 48 CFR 52.227-19. Further, as and when provided to any governmental entity,
government contractor or subcontractor subject to DFARSs, this documentation and the Sterling Commerce Software it describes are
provided pursuant to the customary Sterling Commerce license, as described in Title 48 CFR 227-7202 with respect to commercial
software and commercial software documentation.

These terms of use shall be governed by the laws of the State of Ohio, USA, without regard to its conflict of laws provisions. If you are
accessing the Sterling Commerce Software under an executed agreement, then nothing in these terms and conditions supersedes or
modifies the executed agreement.

Product names mentioned herein may be trademarks and/or registered trademarks of their respective companies. Gentran and
Gentran:Server are registered trademarks of Sterling Commerce, Inc.

Third Party Software:
Portions of the Sterling Commerce Software may include products, or may be distributed on the same storage media with products,
("Third Party Software") offered by third parties ("Third Party Licensors").

Warranty Disclaimer

This documentation and the Sterling Commerce Software which it describes are licensed either "AS IS" or with a limited warranty, as
set forth in the Sterling Commerce license agreement. Other than any limited warranties provided, NO OTHER WARRANTY IS
EXPRESSED AND NONE SHALL BE IMPLIED, INCLUDING THE WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
USE OR FOR A PARTICULAR PURPOSE. The applicable Sterling Commerce entity reserves the right to revise this publication from
time to time and to make changes in the content hereof without the obligation to notify any person or entity of such revisions or
changes.

The Third Party Software is provided 'AS IS' WITHOUT ANY WARRANTY AND ANY EXPRESSED OR IMPLIED WARRANTIES,
INCLUDING BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. FURTHER, IF YOU ARE LOCATED OR ACCESSING THIS SOFTWARE IN THE UNITED STATES,
ANY EXPRESS OR IMPLIED WARRANTY REGARDING TITLE OR NON-INFRINGEMENT ARE DISCLAIMED.

Sterling Commerce, Inc.
4600 Lakehurst Court Dublin, OH 43016-2000 * 614/793-7000
© Copyright 1995-2005—Sterling Commerce, Inc.




Table of Contents

Preface About This Guide
D Introduction .. ... ... ... v
p  Description of CONtents ... ...ttt e v
D Getting SUPPOIt ..ottt vi

Chapter 1  Connect:Direct Gateway Overview
D OVOIVIEW ittt e 1-2
p  Connect:Direct Gateway .. ... ...ttt e 1-3
» Connect:Direct Gateway Mailboxes ...............cvitiiiininnnenen... 1-4
»  Gateway Message FIow . ... ... i 1-5

Chapter 2 Configuring Communications
p Introduction ... ... ... .. 2-2
Properties .......coiiiiiiiiiiiiiiiiiiiitetttttttttttttotntonnnons 2-4
p  Connect:Direct Gateway .. ... ... ..ottt e 2-4
» Connect:Direct Client Connection Utility .............. ... .ccviiiiinenen... 2-6
» Connect:Direct Mailbox Properties ................ i, 2-10
P MailboX Properties . . .. ..ot 2-17
Procedures .........oiiiiiiiiiiiiiiiiiiiiiiiiiiitiiiiiiiiiieiaaas 2-21
D Configuration PrOCESS . . vttt t ettt ettt ettt et ettt 2-21
» How to Configure Your Connect:Direct Gateway ..................c..oonon.. 2-22
» How to Create Connect:Direct Gateway Mailboxes .......................... 2-25
» How to Modify Mailbox Properties . ............ ..o, 2-28
» How to Use the EAITrigger Program ................... .. .. ... ivivinon.. 2-29
» How to Troubleshoot Common Errors ............ ... .. ... .. ... ........... 2-32

Connect:Direct Gateway Configuration Guide Gentran:Server for Windows — November 2005 ()



Contents

Gentran:Server for Windows — November 2005 Connect:Direct Gateway Configuration Guide



PREFACE

About This Guide

Contents D Introduction. . ... ..ottt v
» Description of Contents. . . ........ovitntet e v
D Getting SUPPOIL. . .ottt ettt e e e vi

Connect:Direct Gateway Configuration Guide Gentran:Server for Windows — November 2005 ()



Introduction

Introduction

Overview

Intended audience

Prerequisite
knowledge

This manual contains the tasks you must follow to:
» configure the Gentran:Server Connect:Direct Gateway

» create Connect:Direct Gateway mailboxes

The intended audience for this manual is:
» Gentran:Server system administrators

» advanced Connect:Direct users

The audience using this software should be familiar with:
»  Your operating system
» Communications protocols

» Connect:Direct functionality

Gentran:Server for Windows — November 2005
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About This Guide Description of Contents

Description of Contents

Introduction This guide is organized into the tasks that you complete when configuring
communications for the Connect:Direct Gateway.

Organization of  The guide is organized into chapters. A brief description of each chapter’s contents
chapters  follows.

» About This Guide explains the content, organization, and conventions in this guide.

» Connect:Direct Gateway Overview provides a high-level overview of the
Connect:Direct Gateway.

» Configuring Communications explains the process for configuring Connect:Direct
Gateway communications. This chapter also provides the procedures you must follow
to configure your Connect:Direct Gateway Mailboxes.

Connect:Direct Gateway Configuration Guide Gentran:Server for Windows — November 2005 (



Getting Support

Getting Support

About This Guide

Introduction Sterling Commerce’s Gentran:Server software is supported by trained product support
personnel who are available to help you with product questions or concerns.

Note

Gentran:Server Customer Support does not support non-Sterling Commerce products
(e.g., SQL Server, Oracle, etc.), but can assist you in configuring non-Sterling Commerce
products to work with Gentran:Server.

Phone number For assistance, please refer to your Getting Started Guide to determine which support

phone number you should use.

Before calling  To help us provide prompt service, we ask that you do the following:

support )

events.

Attempt to recreate any problem that you encounter and record the exact sequence of

»  When you call product support, you should be prepared to provide us with the

information below.

Information

Description

Identification

Your company name, your name, telephone number and
extension, and the case number (if the question refers to a
previously reported issue).

System Configuration

The Gentran:Server version (and any service packs
installed) and information about the primary Gentran
system controller and all machines experiencing
problems, including: the Windows operating system
version, amount of memory, available disk space,
database version, Microsoft Data Access (MDAC)
version, and Internet Explorer version.

Also, please describe any recent changes in your
hardware, software, or the configuration of your system.

System Data Store

Which machines contain folders in the system data store?

Error Messages

Record the exact wording of any error messages you
receive and the point in the software where the error
occurred, as well as any log files.

Attempted Solutions

Record any steps that you took attempting to resolve the
problem and note all the outcomes, and provide an
estimate on how many times the problem occurred and
whether it can be reproduced.

() Gentran:Server for Windows — November 2005
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About This Guide Getting Support

Accessing the The Sterling Commerce Customer Support Web Site contains valuable information about
Sterling getting support for Gentran:Server for Windows, including the:

Commerce ,  scope of support services
Support Web Site .
» customer support policies
» call prioritizing
» customer support phone directory
» how to create new Support on Demand cases
» how to check the status of Support on Demand cases

» how to add information to Support on Demand cases

The Customer Support Web Site is constantly updated and all Sterling Commerce
customers have access to it. This web site also contains the most recent product updates
and is a valuable source of product information.

Reference
Refer to the Getting Started Guide for information on how to access the Customer Support
World Wide Web Site.

Documentation The Customer Support Web Site contains a documentation library, which has the entire
Gentran:Server for Windows documentation set. You can download the product manuals
in PDF format from this library at any time.

Connect:Direct Gateway Configuration Guide Gentran:Server for Windows — November 2005 (
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Connect:Direct Gateway Overview
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Overview

Overview

In this chapter

What is Connect:

Direct?

What is a

Gateway?

What is a
Mailbox?

Connect:Direct Gateway Overview

This chapter provides you with a high-level overview of the Gentran:Server
Connect:Direct Gateway.

Connect:Direct is point-to-point file transfer software that manages how information is
passed between distributed applications.

The local Connect:Direct server is a Windows service that transfers files, invokes
programs, and submits other work to Connect:Direct. The remote Connect:Direct server
runs on any platform that Connect:Direct supports.

Connect:Direct relies on a Process (a series of statements) to initiate system activity. Each
Process contains two nodes:

» A Primary Node (Pnode) - the node on which a Connect:Direct Process is submitted.

» Secondary Node (Snode) - interacts with the Pnode when a Process is executed.

A Gateway is a software component that controls the transmission of messages between
two parties. The gateway is responsible for using the correct protocols to transfer
messages between the sender and receiver.

You are responsible for defining the properties of the gateways that you use for
transferring messages.

A mailbox stores messages until those messages are transferred to a recipient application.
You are responsible for creating mailboxes. When you create mailboxes, you associate the
mailbox with a gateway. The properties that you define for each mailbox determine how
messages are transferred from or to your application via the gateway.

Gentran:Server for Windows — November 2005
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Connect:Direct Gateway Overview Connect:Direct Gateway

Connect:Direct Gateway

Introduction The Connect:Direct Gateway defines the relationships between the Mailbox Server and
the Connect:Direct file exchange system.

Configuring the  You must configure the Connect:Direct Gateway before you can begin transferring or
Gateway  receiving messages. When you configure the gateway, you define the:

» Node Name
» User ID and its associated password
Reference

See Configuring Communications, chapter 2 of this guide, for more information about
configuring the Connect:Direct Gateway.

Connect:Direct Gateway Configuration Guide Gentran:Server for Windows — November 2005
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Connect:Direct Gateway Mailboxes Connect:Direct Gateway Overview

Connect:Direct Gateway Mailboxes

Introduction  In addition to gateway properties, you must also configure Send and/or Receive properties
for Connect:Direct mailboxes.

Reference
See Configuring Communications, chapter 2 of this guide, for more information about
configuring the Connect:Direct mailboxes.
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Connect:Direct Gateway Overview Gateway Message Flow

Gateway Message Flow

Introduction

Message status

Related topic

When a message is sent from the Connect:Direct Gateway to the Connect:Direct server,
subject information is updated to include the:

» Connect:Direct Process number
» Connect:Direct Process name
» Connect:Direct Submitter ID

» Connect:Direct Node name

Connect:Direct uses this information to uniquely identify the Connect:Direct process and
to retrieve statistics (audit) information using the Statistics Monitor in the Connect:Direct
Requestor.

When a message is sent to the Connect:Direct Gateway, the message status is changed to
“Sent.” When the Connect:Direct Gateway submits a process to the Connect:Direct server,
the message status is changed to “Sent Third-Party.” When the Connect:Direct process
completes, the message status is changed to “Delivered” (if the process was successful) or
to “Delivery Failed” (if the process was unsuccessful.).

See Tracking Messages in the Communications User s Guide for more information.
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Introduction

Introduction

In this chapter

Key Terms

Configuring Communications

This chapter describes the tasks that you must complete to configure your Connect:Direct
Gateway and Connect:Direct Gateway Mailbox.

This table describes key terms used in this chapter.

Term

Description

Gateway

Gateways are software components that control the transmission
of messages between two parties. The gateway is responsible for
using the correct protocols to transfer messages between the
sender and receiver.

CCU

The Client Connection Utility is used on the client side to
configure client-to-server communications. This configuration
includes the server name, IP address, User ID, and password.

Mailbox

A folder or set of folders used to store messages.

Connect:Direct

A point-to-point file transfer system.

Network Map

The configuration information for server-to-server
communications, which is also referred to as netmap. The TCP/IP
or SNA information for each node in the network is stored in the
netmap. The netmap is configured through the Requester.

Pnode

The Primary node, on which a Connect:Direct Process is
submitted.

Process

A text file that contains a Connect:Direct statement, which is
created in a scripting language. Processes are submitted from the
client.

Proxy

The component that defines the relationship between a user at a
remote Connect:Direct node and a local User ID. The proxy
removes the need to explicitly specify a User ID and password for
the Snode in the process or on the submit command.

Requester

A client that sends commands to the Connect:Direct server, and
then receives and displays server responses.

Snode

The node that interacts with the Pnode when a Process is
executed.

() Gentran:Server for Windows — November 2005
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Configuring Communications

Introduction

(Contd)
Term

Description

TCQ

The Transmission Control Queue is a job queue on the
Connect:Direct server. The TCQ contains processes that have
been submitted and consists of these four logical queues:

Wait
Exec
Hold

Timer

Connect:Direct Gateway Configuration Guide
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Connect:Direct Gateway Configuring Communications

Properties

Connect:Direct Gateway

Introduction The Connect:Direct Gateway Properties dialog box defines the properties of the
Connect:Direct Gateway.

Connect:Direct  This diagram illustrates the Connect:Direct Gateway Properties dialog box.
Gateway

. Connect:Direct G ateway Properties
Properties
— Connect:Direct Mode
Mode Marne: I j
Uzer D I j
Password; I

Configure |

Update process status every 102 minutes

Cancel | Help

Parts and This table describes the parts of the Connect:Direct Gateway Properties dialog box and
functions  their functions.

Part Function

Node name Identifies the Connect:Direct server (node) to which the
Connect:Direct Gateway is attached.

Note

A Node Name selection is required. If you have not configured a
node, you are prompted to do so using the Client Connection
Utility.

() Gentran:Server for Windows — November 2005 Connect:Direct Gateway Configuration Guide




Configuring Communications

Connect:Direct Gateway

(Contd)
Part

Function

User ID

Identifies a Connect:Direct user associated with the selected Node
name. User IDs are defined for a node using the Client Connection
Utility. Valid User IDs display as drop-down list items on the
Gateway Properties dialog box.

Note
A User ID selection is required. If you have not configured a User
ID, you are prompted to do so using the Client Connection Utility.

Password

Specifies password information (which displays as asterisks for
added security) associated with the selected User ID.

Note

A password is required. If you have not configured a password,
you are prompted to create one using the Client Connection
Utility.

Configure

Launches Client Connection Utility. This enables you to create or
modify nodes and User ID properties.

Update the
process status
every

Defines the time interval (in minutes) at which the Connect:Direct
Gateway updates the status of messages being processed.

OK Saves changes; exits dialog box.
Cancel Cancels unsaved changes; exits dialog box.
Help Launches the online Help system.

Connect:Direct Gateway Configuration Guide
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Connect:Direct Client Connection Utility Configuring Communications

Connect:Direct Client Connection Utility

Introduction The Client Connection Utility enables you to create or modify Connect:Direct node and
User ID properties. These properties must be defined so that the Connect:Direct Gateway
can connect to Connect:Direct.

Client Connection  This diagram illustrates the Client Connection Utility dialog box.

Utility
MWolfgang - Client Connection Utility =] E3
File Edt “iew Options Help
| 0| | =]
For Help, press F1 i

Parts and  This table describes the parts of the Client Connection Utility dialog box and their
functions  functions.

Part Function

Menu Bar Displays Client Connection Utility menu options. Those options
include:
» File
» Edit
» View
» Options
» Help

() Gentran:Server for Windows — November 2005 Connect:Direct Gateway Configuration Guide



Configuring Communications

Connect:Direct Client Connection Utility

(Contd)
Part

Function

Toolbar

Displays Client Connection Utility toolbar items. Those items
include:

» New Mode
» New User
» Save

» Properties

» Delete

Display Window

Displays a list of all configured nodes in the sequential order in
which they were created. Individual Node entries can be expanded
to display associated Users.

Node Properties  This diagram illustrates the Client Connection Utility Node Properties dialog box.
Hode Properties E3
— Connect:Direct Hode
Mame: I
Default User [D: I j
Operating Spstem: I.t’-‘-.utomatic j
— Comrmunication Pratacal
TCPYIP Suppart
Address I
Part: |1353
[ Set as the default node
Cancel | Help
Parts and This table describes the parts of the Client Connection Utility Node Properties dialog box
functions and their functions.

Part

Function

Name

Identifies a Connect:Direct server (node).

Default User ID

Displays the default User ID assigned to this node. If a User ID is
not set as the default, this field displays as inactive.

Operating System

Defines the operating system associated with the node. The
default setting is Automatic.

Connect:Direct Gateway Configuration Guide

Gentran:Server for Windows — November 2005 ()



Connect:Direct Client Connection Utility

Configuring Communications

(Contd)
Part

Function

Protocol properties include:

Communications | Defines node communication protocol properties. Those

» Address - defines the TCP/IP address for the node to which
the Connect:Direct Gateway submits processes.

» Port - defines the port for the node to which the
Connect:Direct Gateway submits processes.

Set as the default | When this option is selected, automatically populates the Logon

node dialog box with the name of this node.
Note
The default node displays in bold type on the Client Connection
Utility dialog box.

OK Saves changes; exits dialog box.

Cancel Cancels unsaved changes; exits dialog box.

Help Launches the online Help system.

User Properties This diagram illustrates the Client Connection Utility User Properties dialog box.

Uszer Properties E3

Lzer Infarmation

Mame;

|
Password: I
Werify Password: I

™ Femember password
™ Set as the default Lzer

Cancel Help

Parts and This table describes the parts of the Client Connection Utility User Properties dialog box

functions and their functions.

Part Function
Name Identifies the User you want to associate with the node.
Password/ Defines (and confirms) the User password.
Verify Password

Gentran:Server for Windows — November 2005
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Configuring Communications Connect:Direct Client Connection Utility

(Contd)
Part Function
Remember When this option is selected, it specifies that you want
Password Connect:Direct to automatically reload specified password

information.

Set as the default | Selecting this option identifies this user as the default user for a
User specific node.

Notes

» A default User value automatically displays in the Node
Properties dialog in the Default User ID field of the Node
Properties dialog box. When its associated node is selected as
the Node Name of the Connect:Direct Gateway Properties
dialog box, the default User ID displays in the User ID field
of that dialog.

» The default user displays in bold type under its associated
node in the Client Connection Utility.

OK Saves changes; exits dialog box.
Cancel Cancels unsaved changes; exits dialog box.
Help Launches the online Help system.

Connect:Direct Gateway Configuration Guide Gentran:Server for Windows — November 2005 ()



Connect:Direct Mailbox Properties

Configuring Communications

Connect:Direct Mailbox Properties

Introduction The Send and Receive tabs of the Connect:Direct Mailbox Properties dialog box define
the mailbox properties of the Connect:Direct Gateway.

Send tab This diagram illustrates the Send tab of Connect:Direct Mailbox Properties dialog box.

Connect-Direct Mailbox Properties for connectdirect

e, er| [0

Parts and This table describes the parts of the Send tab of Connect:Direct Mailbox Properties dialog
functions  box and their functions.

Part

Function

Send messages
from this mailbox

Specifies that you want to send messages from this mailbox.

Pnode

Identifies the primary node (server name). This value represents
the Node Name selected on the Connect:Direct Gateway
Properties dialog box.

(Continued on next page)
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Configuring Communications

Connect:Direct Mailbox Properties

(Contd)
Part

Function

Snode

Identifies a secondary node and its associated User ID and User
password.

Note

You must specify an Snode Name, User ID, and Password unless
you are using an existing process that has the Snode, User ID, and
Password coded on the process statement or you are using a proxy
on the remote Connect:Direct node.

Process Options

Specifies how you want to create the Connect:Direct process.
Options are:

» Create dynamic process - selection specifies that you want the
Connect:Direct Gateway to create the process.

— Process Name - specifies the name of the process that
you want the Connect:Direct Gateway to create. This
name can be 1- to 8-characters. The default process name
is CDADAPT.

— Delete source file after successful copy - adds a step to
the Connect:Direct process that checks the return code of
the Copy, and then executes a Run Task to delete the
source file.

— Save process - allows a dynamic process to be saved in a
file. The filename is the same as the process name with a
.cdp extension (the default Process Name is cdapapt.cdp).
This file is stored in specified Source File location.

Note

This feature is only used for debug purposes. Each time
the system creates a dynamic process, it overwrites a
saved process file with the new process information.

»  Use existing process - enables you to select a previously
created process from a file.

— File name - specifies the full path and filename to the
existing process. The path and filename can be manually
entered or you can use Browse to navigate to the
location.

Connect:Direct Gateway Configuration Guide
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Connect:Direct Mailbox Properties

Configuring Communications

(Contd)
Part

Function

Process Options | »
(contd)

Check for completion status for minute(s) - The
Connect:Direct Gateway checks the Connect:Direct TCQ
every minute for the specified interval to determine whether
the process is complete.

Note

If the process does not complete in the specified amount of
time, the status is checked based on the interval set in the
Update process status field on the Connect:Direct Gateway
Properties dialog box.

Start Date Specifies the day or date of when you want the process to start.
The default is Day: TODAY.

Start Time Specifies whether you want the process to start immediately or a
specific time.

The default is Time: IMMEDIATE.

Attachment Specifies how you want to send an attachment in a Connect:Direct
Options process. Options are:

Append all attachments to a single file - specifies that you
want all attachments appended to a single file. When this
option is selected, you must designate the output filename.

Example
cdgateway.txt

Put each attachment in a separate file - specifies that
attachments should be transferred as multiple-copy items
within the same process.

— Filename Options - becomes active when you select Put
each attachment into a separate file. Options are:

—~Use the original attachment filename - allows the
original filename to be used as the output filename
(default).

Gentran:Server for Windows — November 2005
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Configuring Communications

Connect:Direct Mailbox Properties

(Contd)
Part

Function

Attachment
Options
(contd)

—Use the following to build filename - output file is
created with a specified prefix and extension.

—Prefix - specifies the prefix for the output file.

—Extension - specifies the extension for the
output file.

Note

The filename that is created when the prefix and
extension are combined with the message ID and
unique number must be a valid name on the remote
system.

Example
[prefix]messid_n.[extension]

File Locations

Specifies the path and filename of the source and destination files.

» Source file location - this file must be accessible by the
Connect:Direct Gateway.

» Destination file location - this may or may not be accessible
by Connect:Direct Gateway.

Note

If the Source or Destination File location is installed on an
unmapped Windows network drive of a remote machine, you must
use the Universal Naming Convention (UNC).

Example
\\cdirectserver\cdirect\temp\file1.txt

Note
All special characters required by a remote operating system to
create a valid filename must be entered.

Example (Windows)
c:\test\

OK

Saves changes; exits dialog box.

Cancel

Cancels unsaved changes; exits dialog box.

Help

Launches the online Help system.

Connect:Direct Gateway Configuration Guide
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2-14 Connect:Direct Mailbox Properties Configuring Communications

Receive tab  This diagram illustrates the Receive tab of Connect:Direct Mailbox Properties dialog box.

Connect:-Direct Mailbox Properties for connectdirect

Parts and This table describes the parts of the Receive tab of Connect:Direct Mailbox Properties
functions dialog box and their functions.

Part Function

Receive messages | Specifies that you want this mailbox to receive messages.

into this mailbox (Continued on next page)
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Configuring Communications

Connect:Direct Mailbox Properties

(Contd)
Part

Function

Folder

Receive files from this folder - specifies the path and filename
where you want the Connect:Direct Gateway to send files
Mailbox Server. You can manually enter this information or
use Browse to navigate to the location.

Note
The Receive folder is only required if the Method in which
you want Connect:Direct to receive files is set to Polled.

If method in which you want Connect:Direct to receive files
is set to Triggered, you can either type the name of receive
folder in the Receive files from the folder field or in the
EAITrigger command of the Run Task statement.

Use sub folders to represent email - specifies that you want
the email value to be the same as that of a sub folder name
value.

Method

Specifies the method in which you want the Connect:Direct
Gateway to receive files.

Triggered - uses the EAITrigger Program to send a command
to Connect:Direct. The command notifies the Connect:Direct
Gateway that there are files to retrieve. The gateway
processes the files from the receive folder specified in the
Receive files into this folder field or from the EAITrigger
command of the Run Task statement.

Polled - scans the receive folder at the specified interval.

— Poll folder every minutes - denotes how often you want
the Connect:Direct Gateway to scan the receive folder.

Messages

Specifies message recipients and how you want to messages to be
constructed.

Edit Recipient - launches the Edit Recipient dialog box.
Enables you to add or modify recipients.

How should this message be constructed? - specifies how you
want to receive messages when more than one is in the
Receive folder. Options are:

— Create a single message with all files in one attachment.
— Create a single message with an attachment for each file.

— Create a message for each file.

Connect:Direct Gateway Configuration Guide
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Connect:Direct Mailbox Properties

Configuring Communications

(Contd)
Part Function
Attachment Specifies what you want as the content type for attachments
Content Type received. Options are:

» Use registered MIME type - specifies that you want to use a
registered Multipurpose Internet Mail Extension (MIME)
type.

»  Use this Content Type - enables you to specify a Content

Type.

Message Content | Specifies what you want as the content type for messages

Type received. Options are:
» Use Content Type of the first attachment.
» Use this Content Type - enables you to specify a Content
Type.
OK Saves changes; exits dialog box.
Cancel Cancels unsaved changes; exits dialog box.
Help Launches the online Help system.

Gentran:Server for Windows — November 2005

Connect:Direct Gateway Configuration Guide



Configuring Communications Mailbox Properties

Mailbox Properties

Introduction The Mailbox Properties dialog box enables you to define the properties of the mailbox.

Addressing Tab  This diagram illustrates the Addressing tab of the Mailbox Properties dialog box.

Mailbox Properties x|

Addressing |Gateway| Delivery Rules | Securiy |

Mame :

Gentran EMail Address

The Gentran EMail addrezs will appear on all mezsages zent from the mailbos, It
ig alzo uzed to route incoming meszages to the mailbox.

ok I Cancel Help

Parts and This table describes the parts of the Addressing tab of the Mailbox Properties dialog box
functions and their functions.

Part Function
Name Defines the name of the mailbox.
Gentran Defines the Gentran e-mail address for messages sent from the
Email address mailbox.
OK Saves changes; exits dialog.
Cancel Closes dialog without saving changes.
Help Accesses online help.
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Gateway Tab This diagram illustrates the Gateway tab of the Mailbox Properties dialog box.
Mailbox Properties
Addiessing  Gatewap | Drelivery Hulesl Securit_l,ll
€ This mailbox is not a gateway

% This mailbox is a gateway

Type [COMNECTDirect =]

Canfigure. .. |

Cancel | Help |

Parts and This table describes the parts of the Gateway tab of the Mailbox Properties dialog box and
functions their functions.

Part Function
This mailbox is Specifies whether the mailbox is or is not a gateway.
not a gateway
Options are:
This mailbox is a » This mailbox is not a gateway
gateway
» This mailbox is a gateway
Type Specifies the type of gateway. Activated when the This mailbox is
a gateway option is selected.
Configure Enables you to configure properties for the gateway.
OK Saves changes; exits dialog.
Cancel Closes dialog without saving changes.
Help Accesses online help.
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Mailbox Properties

Delivery Rules Tab  This diagram illustrates the Delivery Rules tab of the Mailbox Properties dialog box.
Mailbox Properties x|
Addiessing | Gateway Delivery Rules |Securit_l,J|
Wwhen Gentran: Server Mailbox delivers messages. it can automatically process
them with Delivery Agents in accordance with rules that you specify.
Mame | Direction | Sender/R... | Aagent | Mew... |
Ediit... |
Delete |
Mowve Up |
tove Down |
oK I Cancel | Help |
Parts and This table describes the parts of the Delivery Rules tab of the Mailbox Properties dialog
functions box and their functions.
Part Function
Name Defines the name of the Delivery Rule.
Direction Identifies if the rule is run when sending or receiving a message.
Sender/ Identifies the mailbox of the sender or recipient. The mail address can
Recipient be specified in addition to the mailbox name.
Agent Identifies the name of the delivery agent to be run.
New Enables you to create new Delivery Rules.
Edit Enables you to edit existing Delivery Rules.
Delete Enables you to delete Delivery Rules.
Move Up Moves the selected Delivery Rule up in the processing order.
Move Down | Moves the selected Delivery Rule down in the processing order.
OK Saves changes; exits dialog.
Cancel Closes dialog without saving changes.
Help Accesses online help.

Connect:Direct Gateway Configuration Guide
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Security Tab This diagram illustrates the Security tab of the Mailbox Properties dialog box.

Mailbox Properties
Addlessingl Gatewayl Delivery Rules  Security |

'ou can uze zecurity bo restrict acceszs to mailboxes that might contain sensitive
infarmation. The list below shows the users and groups that have access to the
mailbox, and what rights they are granted.

@Evewone Full Control

Add...
Tuope of Accezs: j —
Remove |

Cancel | Help |

Parts and This table describes the parts of the Security tab of the Mailbox Properties dialog box and
functions their functions.

Part Function
(User list) Defines users and groups that have access to mailbox.
Type of Designates level at which a user can interact with a mailbox.
Access
Values are:

» Full control

» Read

» Write
Add Enables you to grant users or groups mailbox access.
Remove Enables you to remove user or group mailbox access.
OK Saves changes; exits dialog.
Cancel Closes dialog without saving changes.
Help Accesses online help.
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Procedures

Configuration process

Configuration process

Connect:Direct  This table lists the stages in configuring communications for use with Connect:Direct

Gateway process  Gateway.

Stage

Description

1

Install the Connect:Direct software.

Reference
Refer to the documentation that came with your Connect:Direct
software for installation instructions.

Install the Gentran:Server Connect:Direct Gateway.

Reference
Refer to the Gentran:Server Options Pack Installation Card for more
information.

Configure the Connect:Direct Gateway in Mailbox Server.

Reference
See How to Configure Your Connect:Direct Gateway on page 2 - 22 for
more information.

Create the Connect:Direct Gateway Mailboxes that you intend to use.

Reference
See How to Create Connect:Direct Gateway Mailboxes on page 2 - 25
for more information.

Connect:Direct Gateway Configuration Guide
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How to Configure Your Connect:Direct Gateway

Introduction  This gateway is used for sending and receiving messages through a Connect:Direct
messaging system.

Before you begin Before you begin configuring your Connect:Direct Gateway you must configure your
Connect:Direct messaging software

Reference
Refer to the documentation that came with your Connect:Direct messaging software for
more information.

Procedure  Use this procedure to configure your Connect:Direct Gateway.

Step Action

1 Start Mailbox Server Manager.

System Response
The system displays the Mailbox Server Manager.

2 Select Connect:Direct from the Gateway folder icon.
3 Right-click and select Properties to define the properties for this
gateway.
4 Use this table to determine your next step.
IF the system displays... THEN continue with...
A prompt stating that No Step 5
Connect:Direct nodes have been
configured,
The Connect:Direct Gateway Step 23
Properties dialog box,

5 Click OK to acknowledge the prompt.

System Response
The system displays the Client Connection Utility dialog box.

6 From the File menu, select New Node.

System Response
The system displays the Node Properties dialog box.

7 Enter the name of the Node.
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How to Configure Your Connect:Direct Gateway

(Contd)
Step

Action

8

Enter the Communication Protocol information.

9

Do you want to select this node as the default?

» Ifyes, select the Set as the default node check box. Continue with
the next step.

» Ifno, continue with the next step.

10

Click OK to save your changes and to exit the dialog box.

System Response
You return to the Client Connection Utility dialog box. The node that
you created lists in the window display.

11

Do you want to create additional nodes?

» Ifyes, repeat Steps 6 to 10 for each additional node that you want
to create. Continue with the next step.

» Ifno, continue with the next step.

12

Highlight the node for which you want to associate a user.

13

From the File menu, select New User.

System Response
The system displays the User Properties dialog box.

14

Enter the user name in the Name field.

15

Enter a user password in the Password field.

16

Re-type the user password in the Verify Password field.

17

Select the Remember password option.

Note
Gentran:Server requires a password to log on to the Connect:Direct
server. As a result, you must select the Remember password option.

18

Do you want to specify this user as the default user for the associated
node?

» Ifyes, select the Set as the default user check box. Continue with
the next step.

» Ifno, continue with the next step.

19

Click OK to save your changes and to exit the dialog box.

System Response
You return to the Client Connection dialog box. The user that you
created displays under its associated node.

Connect:Direct Gateway Configuration Guide
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(Contd)
Step

Action

20

Do you want to create additional users?

» Ifyes, repeat Steps 12 to 19 for each additional user that you want
to create.

Note
If more than one user has been set as the Default user, the system
recognizes the most recent User ID entered as the default.

» Ifno, continue with the next step.

21

From the File menu, select Save.

22

From the File menu, select Exit.

System Response
You exit the Client Connection Utility and return to the Connect:Direct
Gateway Properties dialog box.

23

Select the desired Node Name and User ID from the appropriate lists in
the Connect:Direct Gateway Properties dialog box.

24

Do you want to specify a time interval of when the Connect:Direct
Gateway should check for messages in the Inbox?

» Ifyes, specify a time interval in the Update process status every
minute(s) box.

» Ifno, continue with the next step.

25

Click OK to complete the configuration of this gateway.

Note
You are now ready to create gateway mailboxes.

Reference
See How to Create Connect:Direct Gateway Mailboxes on page 2 - 25
for instructions.
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How to Create Connect:Direct Gateway Mailboxes

How to Create Connect:Direct Gateway Mailboxes

Introduction  After you have configured the Connect:Direct Gateway, you must create Connect:Direct
Gateway Mailboxes.

Procedure  Use this procedure to create Connect:Direct Gateway Mailboxes.

Step

Action

1

Start the Mailbox Server Manager.

2

Select the Mailboxes folder icon.

3

Right-click, and select Create from the short-cut menu.

System Response
The system displays the Create Mailbox Wizard dialog box.

Type the name and description of the mailbox you are creating and
click Next twice.

System Response
The system displays a dialog asking whether you want to use the
mailbox as a gateway to another messaging system.

Select Yes, use this mailbox as a gateway.

Select Connect:Direct from the list. Click Next to advance the wizard.

System Response
The system displays the Create Mailbox Wizard - Summary dialog box.

Is the information that you entered correct?
» Ifyes, click Finish. Continue with the next step.

» Ifno, click Back to correct the information. Continue with the next
step.

System Response
The system displays the Gentran Mailbox Properties dialog box.

Note

If you attempt to create a mailbox and the data store is missing, the
system generates an error message box informing you that the mailbox
cannot be created. Click OK to exit the message box and click Cancel
to exit the Create Mailbox Wizard.

Do you want to configure Send properties?
» Ifyes, continue with the next step.

» Ifno, continue with Step 17.

Connect:Direct Gateway Configuration Guide
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(Contd)
Step

Action

9

Select the Send messages from this mailbox check box.

10

Enter the Snode Name, User ID, and Password.

11

Select the desired process options.

12

Select the desired Start Date and Start Time options.

13

Select the desired Attachment options.

14

Enter the Source file location information.

Note

If the Source file location is installed on an unmapped Windows
network drive of a remote machine, you must use the Universal
Naming Convention (UNC).

Example
\\CDirectserver\cdirect\temp\filel.txt

15

Enter the Destination file location information.

Note

If the Destination file location is installed on an unmapped Windows
network drive of a remote machine, you must use the Universal
Naming Convention (UNC).

Note
All special characters required by a remote operating system to create a
valid filename must be entered.

Example (Windows)
c:\test\

16

Do you want to configure Receive properties?
» Ifyes, continue with the next step.

» Ifno, click OK to save changes and to exit the Connect:Direct
Mailbox Properties dialog box.

17

Select the Receive tab.

18

Select the Receive messages into this mailbox check box.

19

Enter the path and filename of the receive folder in the Receive files
from this folder box.

20

Enter the method by which you want to receive files.

Note
If you selected Trigger as the method, see How to Use the EAITrigger
Program on page 2 - 29 for more information.
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How to Create Connect:Direct Gateway Mailboxes

(Contd)
Step

Action

21

Click Edit Recipients.

System Response
The system displays the Edit Recipients dialog box.

22

Select a recipient from the list or enter the name in the box.

Note
You can also select a predefined distribution list.

Reference
See the Communications User s Guide for information on how to create
a Distribution List.

23

Click the appropriate routing option. Valid options are:
» To

» CC

» BCC

System Response
The system displays the Email Address dialog box.

24

Do you want to specify a Email?
» Ifyes, enter the Email in the box. Click Add. Click OK.

» Ifno, click Cancel.

System Response
You return to the Edit Recipients dialog box.

25

Do you want to add more recipients?

» Ifyes, repeat Steps 22 to 24.

» Ifno, continue with the next step.

26

Click OK to return to the Receive tab and continue with the next step.

27

Select the desired message options.

28

Select the desired attachment Content Type.

29

Select the desired message Content Type.

30

Click OK to save changes and exit the Connect:Direct Mailbox
Properties dialog box.
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How to Modify Mailbox Properties

Introduction This section describes how to modify mailbox properties that were created using the
Create Mailbox Wizard.
Procedure  Use this procedure to modify mailbox properties.

Step Action
1 Start the Mailbox Server Manager.
2 Expand the Mailboxes folder.
3 Select the mailbox for which you want to add or modify

properties.

4 Right-click and select Properties from the shortcut menu.

System Response
The system displays the Mailbox Properties dialog box.

5 Use this table to determine your next step.
IF you want to change the
mailbox... THEN click this tab...
» name Addressing
» Gentran E-mail address
» Gateway properties Gateway
» Configuration properties
delivery rules Delivery Rules
user security permissions Security
6 Make the appropriate modifications and then click OK to save

changes and to exit the dialog box.
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How to Use the EAITrigger Program

Introduction The EAITrigger Program is an external program that enables Connect:Direct messaging
software to prompt the Connect:Direct Gateway to retrieve data from the:

» receive folder specified on the Receive tab of the Connect:Direct Mailbox Properties
dialog box, or the

» folder specified in the EAITrigger parameters defined in a Connect:Direct Process as
part of a Run Task statement.

To invoke the EAITrigger program, you create a Connect:Direct Process that includes a
Run Task statement. The Run Task statement specifies EAITrigger Program parameters,
which prompt the Connect:Direct Gateway to retrieve data from the specified receive
folder.

Before you begin Before you can use the EAITrigger program, you must create a Connect:Direct Process on
the Connect:Direct server. This Process must include a Run Task statement that invokes
the EAITrigger Program on the Gentran:Server system.

In the Connect:Direct Gateway, you must select Triggered as the Method option on the
Receive tab of the Connect:Direct Mailbox Properties dialog box.

Valid Parameters This table describes valid command line parameters.

Use command line Is this parameter
To specify... parameter.... required or optional?
Information Hub Server -h Required
Host name or IP address
Source mailbox name -C Required
Option number -0 Optional
Folder name [Receive folder name] Optional
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Syntax Example

Example
Process 1

This is an EAITrigger Program syntax example.

SYSOPTS="PGM (x:\install folder\Bin\EAITrigger)
ARGS (-h Hub -c Mailbox -o Option# parm)"

Where:
» x specifies the drive on which Gentran:Server is installed.
» install folder specifies the folder on which Gentran:Server is installed.
»  Hub specifies the name of the Mailbox Server Manager.
» Mailbox specifies the name of the Connect:Direct Gateway Mailbox.
»  Option# specifies the numeric option, where:

— 1 specifies that files should be received from the folder

defined on the Receive tab of the Connect:Direct Mailbox Properties dialog box.

— 2 specifies that parm is the folder from which files should be received.

Note
The default is 2. It does not need to be specified if parm is specified.

» parm specifies the folder from which files should be received.

This is an example of a Connect:Direct Process that instructs the Connect:Direct Gateway
to retrieve files from the Receive folder specified on the Receive tab of the Connect:Direct
Mailbox Properties dialog box.

/*BEGIN REQUESTER COMMENTS
SPNODES="notest" $PNODE OS$="Windows"
SSNODES="NOTEST" $SNODE OS$="Windows"
$OPTIONSS="WDOS"

END REQUESTER COMMENTS*/

EATI PROCESS SNODE=NOTEST

STEP1 RUN TASK (PGM=WindowsNT/95)
SYSOPTS="PGM (\\ntserver1 \GENSRVNT\BIN\EAITRIGGER.EXE)
ARGS (-h ntserverl -c cd -o 1)"

PEND

Where:
» ntserverl specifies the name of the Gentran:Server server.
» cd specifies the name of the Connect:Direct Gateway Mailbox.

» -o1instructs Gentran:Server to use the Receive folder specified on the Receive tab of
the Connect:Direct Mailbox Properties dialog box.

Gentran:Server for Windows — November 2005
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Example
Process 2

How to Use the EAITrigger Program

This is an example of a Connect:Direct Process that instructs the Connect:Direct Gateway
to retrieve files from the machine and receive folder specified in the EAITrigger Program
parameters.

/*BEGIN REQUESTER COMMENTS
SPNODES="notest" $PNODE OS$="Windows"
$SNODES$="NOTEST" $SNODE OS$="Windows"
$OPTIONSS$="WDOS"

END REQUESTER COMMENTS*/

EAI PROCESS SNODE=NOTEST

STEP1 RUN TASK (PGM=WindowsNT/95)
SYSOPTS="PGM (\\ntserverl1 \GENSRVNT\BIN\EAITRIGGER.EXE)
ARGS (-hserverl -c cd \\notest\receive)"

PEND

Where:
» ntserverl specifies the name of the Gentran:Server server.
» cd specifies the name of the Connect:Direct Gateway Mailbox.

» \\notest\receive instructs Gentran:Server to retrieve files from the Receive folder on
the machine “notest.”
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Configuring Communications

How to Troubleshoot Common Errors

Introduction

Related topic

Connect:Direct errors that the Connect:Direct Gateway encounters as a result of process
creation or submission are noted in the Event Log and in the Gentran:Server Audit
Notification Server.

These messages typically include an 8-character message ID and a brief description of the
error message. You can view a more detailed error message description by means of the
Message Lookup facility in the Connect:Direct Requester.

Common errors include:

LCOAO014I Client supplied bad username or password

Reason: User ID or password is invalid.

Solution: Modify user information through the Client Connection Utility. To access
the Client Connection Utility, click Configure on the Gateway Properties dialog box.

TCPIP: WSAECONNREFUSED - The connection was refused. The server may
be down.

Reason: The Connect:Direct server is down.

Solution: Notify your Connect:Direct Administrator. Verify that the Connect:Direct
server is up and running.

<0or>

Reason: Wrong node information configured (typically this is due to a bad IP
address).

Solution: Modify node information through the Client Connection Utility. To access
the Client Connection Utility, click Configure on the Gateway Properties dialog box.

See “Using the Audit Notification System” in the Administration Guide for additional
information on other Gentran:Server errors.
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